
 

ACCOUNTING AID SOCIETY 

STEP BY STEP INSTRUCTIONS FOR VOLUNTEER TAX PREPARERS 
Last Updated 1/9/2026 

OVERVIEW OF TAX RETURN APPOINTMENT 
 

Please note: following the Overview, everything is described in greater detail 
 
1. CONDUCT INTAKE/INTERVIEW WITH TAXPAYER 
★​ Collect picture ID and Social Security documentation from client (a photo or copy is acceptable) 

               If MFJ, both must be present with ID 
               Social Security cards must also be presented for all dependents 
★​ Complete Federal Intake/Interview Sheet (each line must be answered with yes or no) 
★​ Complete AAS Supplemental Michigan Intake/Interview Sheet 
★​ Complete Taxpayer Return Questions 

 

 

2. PREPARE TAX RETURN IN TAXSLAYER PRO ONLINE 2026 

 

     TaxSlayer Task 1: Enter Basic Information 
★​ Taxpayer/Spouse Information 
★​ Filing Status (DO NOT use the Filing Status Wizard button) 
★​ Dependent Information 
★​ Identity Protection PIN 

 

     TaxSlayer Task 2: Complete Federal Section 
★​ Federal Income (See Table 1) 
★​ Expenses (See Table 2) 
★​ Life Events (See Table 3) 
★​ Health Insurance (See Table 3) 

 

     TaxSlayer Task 3: Complete State Section 
★​ Basic Information 
★​ Subtractions from Income – Pensions (See Table __) 
★​ Credits 

○​ Homestead Property Tax Credit (See Table__) 
○​ Home Heating Credit (See Table__) 
○​ Total Household Resources – Non-taxable Income, Medical Insurance Premiums (See Table__) 

★​ Complete City of Detroit Return, if client is a:​  
○​ Resident (See Table__) 
○​ Non-Resident (See Table__) 
○​ Part-Year Resident (See Site Coordinator) 

★​ Complete Return for other Taxable Cities (ex: Hamtramck, Highland Park, Pontiac), if client is a: 
○​ Resident or Non-Resident (See Table__) 
○​ Part-Year Resident (See Site Coordinator) 

★​ Record amounts for Property Tax Credit, Home Heating Credit and City Refund/Balance Due on the Preparer 
Return Questions Form. 
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     TaxSlayer Task 4: E-File Page: Prepare Return for Filing 
 
★​ Select Federal Return AND State Return Types 
★​ Enter Client Email Address, if provided 
★​ Enter Banking Information (if opting for direct deposit, savings bonds, or splitting of Federal Refund) 
★​ Taxpayer Consent: Have client (and Spouse) sign Global Carry Forward and Relational Office Consent Form 
★​ Custom Questions: Enter client’s responses from Taxpayer Return Questions 
★​ Custom Credits: Enter amounts from Preparer Return Questions 
★​ Submission Page – Print QR page 1 and have client check their personal information 

 

3. QUALITY REVIEW & PRESENTATION OF TAX RETURN 
 
★​ Explain final steps of our process to client and ask for a Quality Review  
★​ Reviewer checks entire return and prints client’s copy 
★​ Compile Return and present it to the client 

 

 

CONDUCTING TAXPAYER INTAKE/INTERVIEW 

The intake/interview process provides the Tax Preparer with all information needed to complete a tax return. It is 

required that both intake forms are fully filled out before beginning the return in TaxSlayer, with no questions skipped. 

For any boxes checked on the Federal Intake Sheet, the client should have a corresponding tax form.  

IMPORTANT NOTES ABOUT THE INTAKE PROCESS 

●​ MISSING DOCUMENTS: If a document is missing, finish the intake process to ensure nothing else is missing. 

Complete a Missing Information Form for your client and ask them to reschedule their appointment once they 

have gathered everything that they need. There are two missing items that often cause a return to be rejected 

upon transmission: IP PIN and 1095-A (Marketplace Insurance form). Always ask about these and, if they are 

missing, offer advice on how to retrieve them 

●​ SCOPE OF SERVICE: A tax return may be out of scope for VITA because of guidelines given to us by the IRS 

○​ The 2025 income limit is $69,000. If a client has a higher income, see your Site Coordinator. 

○​ Receiving rental income is out of scope 

○​ Self-Employment is out of scope IF: the business has expenses greater than $50,000, involves holding 

inventory, pays employees, operates at a loss, or client wants to deduct the use of home as a workspace. 

○​ For self-employed drivers, gas expenses can be calculated by using business miles only. 

○​ Digital Assets: Purchasing digital assets with real currency during the tax year or holding digital assets 

may still be in scope. All other crypto activity is out of scope. 

When in doubt about an item being in scope for VITA, refer to the Scope of Service chart and instruction pages 

in Pub 4012, page VI Volunteer Resource Guide, or ask your Site Coordinator. 
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COLLECT IDENTIFICATION 

The very first step in the process is to collect the following required identification documents: 

●​ Photo Identification (one of the following for taxpayer AND spouse if married filing jointly): 

○​ State-issued driver’s license 

○​ State-issued ID card 

○​ U.S. passport or passport card 

○​ Military ID​
 

●​ Taxpayer Identification (taxpayer, spouse AND all dependents listed on the return): 

○​ Social Security card or Individual Taxpayer Identification Number (ITIN) card/letter 

Notes: 

●​ Photocopies or photos of the documents are acceptable. 

●​ Typically, these documents are held during the appointment and returned by the Quality Reviewer after verifying 

all information. 

 

FEDERAL INTAKE SHEET 

1)​ BASIC INFORMATION - Complete ALL Questions. Important Reminders:  
a)​ Mailing address: Check the back of ID for updating address and confirm with the client that they wish to 

use the address on their ID as their mailing address 

b)​ If a client indicates they lived or worked in 2 or more states, let them know we can only complete a 

return for Michigan and they will still need to go somewhere else to file the other state(s) 

c)​ If a client and/or spouse indicate they are not a U.S. citizen or are in the U.S. on a visa - consult the 4012 

and your site coordinator to confirm the return is in scope 

d)​ Identity Protection PIN - Some clients require this 6-digit code in order to file their taxes electronically. 
They should have received Notice CP01A from the IRS providing their Identity Protection PIN (IP PIN) for 
2026, check the  date on the letter is  the current year date. If the Taxpayer should have an IP PIN and 
does not, it can be found in the client’s irs.gov account. It may be necessary to set up an ID.Me account. 
(Instructions for this process can be found at Tax Preparer Tools > Client Assistance Tools >  IRS Account 
- ID.Me) If the IP PIN is not found, the return must be paper filed. Always ask every client: 

i)​ Have you ever been issued an Identity Protection PIN (IP PIN) by the IRS? 

ii)​ Have you used one in the past or been a victim of tax-related identity theft? 

Tips for identifying an IP PIN (clients may not recognize the term): 

●​ Ask if their return has ever been rejected or if they had to file paper instead of electronically 
file. 

●​ Ask if they receive letters from the IRS with a special code. 
●​ Ask if they retrieve a code online each year to file their return. 
●​ Ask if AAS has ever called them after filing to ask for a PIN code. 
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●​ Ask if anyone else has ever filed their return on their behalf. 

Why this matters: 

●​ IP PIN issues are one of the top causes of rejected returns. 
●​ Asking in multiple ways helps ensure clients don’t forget or misidentify the PIN. 

2)​ REFUND/PAYMENT OPTIONS 

a)​ Direct deposit – client must provide routing and account numbers via: 

i)​ A check, 

ii)​ A bank card 

iii)​ Bank account statement 

iv)​ Their banking app on their phone. 

*If proof of banking information is not available, seek guidance from the site coordinator.* 

b)​ Paper check 

i)​ Still available for Michigan residents and is the only option for certain localities. 

ii)​ IRS no longer issues paper checks except when required due to missing banking info or 

exceptions: 

(1)​ If banking info is missing or a direct deposit is rejected, the IRS will send a letter 

requesting updated information within 30 days and the “Where’s My Refund” tool will 

also display a notification. 

(2)​ Taxpayers can update banking info through their Individual Online Account. 

(3)​ Refunds may be held for up to 6 weeks if info or exceptions are missing. 

(4)​ Once info is provided, the refund is released immediately via direct deposit or paper 

check. 

(5)​ After 6 weeks, if no info is provided and no other issues exist, the refund is issued as a 

paper check. 

c)​ CFR Card – Encourage all clients to enroll, especially for clients without bank accounts.  See site 

coordinator to enroll clients. 

i)​ Client must sign both sides of the “Consent to Disclosure of Tax Return Information” form to 

enroll in a CFR card ( See Site Coordinator ) 

d)​ Balance due 

i)​ Direct debit from the return is not offered (AAS policy) for safety reasons 

ii)​ Clients can pay online via the IRS portal: 

(1)​ Provide clients with the payment information and  

(a)​ Assistance to the client with navigating the online payment is limited to site 
capacity and should be offered if they have no one else to assist. 

NOTE: If a client is due a federal refund, doesn’t have a bank account and declines the CFR card, see your site 

coordinator 

3)​ FILING STATUS 

a)​ The State of Michigan has three filing statuses. Those filing HOH or QSS on the Federal return will be 

Single on their Michigan return 
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b)​ Michigan does not recognize Legal Separation so this is not an option for our clients 

c)​ ALWAYS use the decision tree to determine filing status after the questions on the intake are answered 

(4012 Page B13) Write the determined filing status from the list below somewhere in the filing status 

section on the federal intake. 

i)​ SINGLE: Taxpayer is unmarried as of 12/31/2025 and not claiming any dependents 

ii)​ MARRIED FILING JOINTLY (MFJ) 

(1)​ Both spouses must be present (Power of attorney is required if one of the spouses is not 

present) 

(2)​ If the clients have filed with AAS before, use the same Primary Taxpayer to allow 

information to be pulled from past returns 

(3)​ Injured Spouse Form (Form 8379): 

(a)​ If one spouse owes past-due obligations (tax debt, child support, student loans, 

etc.), the other spouse may file jointly and still protect their portion of the 

refund. 

(b)​ This allows the spouse who is not liable for the debt to claim their share of the 

refund. 

(c)​ Encourage clients who are considering Married Filing Separately due to 

concerns about refunds being applied to the other spouse’s debts to discuss 

the Injured Spouse form with staff. 

iii)​ MARRIED FILING SEPARATELY (MFS) 

(1)​ Taxpayer is married as of 12/31/2025, even if not living together 

(2)​ Must provide Spouse’s SSN in order to e-file 

(3)​ Generally has a higher tax rate 

(4)​ Not eligible for: Earned Income Credit, education credits, student loan interest 

deduction, and more 

iv)​ HEAD OF HOUSEHOLD (HOH): Must be unmarried (or considered unmarried – see 4012 decision 

tree and Site Coordinator) and have qualifying dependent(s) living with them for more than half 

of the year 

v)​ QUALIFYING SURVIVING SPOUSE: Taxpayer may use this status for two years following their 

spouse’s death as long as they remain unmarried and have qualifying dependent(s) living with 

them for more than half of the year 

4)​ DEPENDENT INFORMATION 

a)​ Complete ALL boxes in this section, especially the grey boxes that say “To be completed by certified 

volunteer” for anyone residing in the household to determine if they can be claimed as a dependent on 

the return. 

5)​ INCOME - All questions MUST be answered by checking the box or indicating that it does not apply to the client 

(Corresponding source documents and references are listed in Tables 1 below) 

a)​ Tip Income - Some tip income is not taxable - if a client indicates they had tips, see site coordinator for 

guidance 
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b)​ Retirement Income - Double check the code in box 7 (codes 5, 8, 9, A, E, J, K, N, P, R, T, U are Out of 

Scope). If box 2 is empty (taxable amount not determined) and there is an amount in box 9, the 

simplified method will need to be used to determine taxable value. This requires advanced certification. 

c)​ Disability Benefits - This question is specifically referring to benefits reported on a w-2 or 1099-R.  

i)​ SSDI is social security income reported on a SSA-1099 (next question) 

ii)​  SSI is nontaxable income that goes on the Michigan intake and return only. 

d)​ Social Security: Determine what kind of social security income is being received. Those receiving SSA or 

SSDI will receive it on the third Wednesday of the month and will have an SSA-1099 to be included on 

their federal return. If they do not have this form, they may receive SSI which goes on the Michigan 

return and is received on the 1st of every month. Dependent SSA/SSDI/SSI goes on the Michigan return if 

it is used towards household expenses.  

e)​ Refund of State or local income tax - only required if they itemized the previous year 

f)​ Alimony - Only taxable if divorce agreement was settled between 1985-2018 

g)​ Rental Income - Out of Scope 

h)​ Self-Employment Income - ALWAYS fill out the 1099-NEC and  Schedule C Worksheet!  

i)​ Check the back of the worksheet to ensure the return is in scope 

ii)​ All self-employment income will require a Schedule C in Taxslayer 

6)​ EXPENSES - All questions MUST be answered by checking the box or indicating that it does not apply to the client 

(Corresponding source documents and references are listed in Table 2) 

a)​ Itemized Deductions - Most clients do not benefit from itemizing deductions (such as mortgage 

interest, medical expenses, or charitable contributions) due to the significant increase to the standard 

deduction in recent years. 

i)​ Before entering any itemized deductions into TaxSlayer: 

(1)​ Add them up first to determine if they are likely to exceed the client’s standard 

deduction. 

(2)​ Do not enter itemized deductions unless they reasonably appear to be greater than the 

standard deduction and would result in a lower taxable income. 

ii)​ If a client asks to itemize, you can explain: 

“With the increased standard deduction, you’ll actually benefit more by taking the standard 

deduction this year — it gives you a larger overall tax break than itemizing would.” 
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It often helps to look up and share their actual standard deduction amount so they have a real 

number for comparison. 

iii)​ If the client still insists on itemizing, please see your Site Coordinator before proceeding. 

b)​ Child and Dependent Care - remember that they must be able to provide an EIN or SSN for the care 

provider to claim the credit! 

c)​ Educator Expense Deduction - most educators qualify for this credit as long as they meet the minimum 

worked hours (900). Verify they have receipts/written evidence of at least $300 in expenses (does not 

need to provide to us, verbal confirmation is fine). 

d)​ Alimony Payments -  Only deductible if divorce agreement was settled between 1985-2018 

7)​ TAX RELATED EVENTS - All questions MUST be answered by checking the box or indicating that it does not apply 

to the client (Corresponding source documents and references are listed in Table 3) 

a)​ Education Credit 

i)​ Use the Education Credit Worksheet 

ii)​ Reminder - all clients claiming this credit should provide the account summary from their 

institution - they can usually go online and pull it up if they do not have any documentation with 

them.  

b)​ Sale of home - only sale of primary residence is in scope! See Pub 4012 or  the Accounting Aid Compass 

for a guide on this topic 

c)​ HSA - client may not know they have an HSA - code w in box 12 of 1040 is a good indicator 

i)​ Client should provide forms:  

(1)​ Form 1099-SA: Distributions From an HSA  

(2)​ Form 5498-SA: HSA: Contributions made to an HSA 

ii)​ If they cannot provide the forms - discuss with the site coordinator 

d)​ Marketplace Insurance (aka Obama Care or ACA): ALWAYS ask what kind of health insurance the client 

has. A 1095-A form must be entered for everyone who had Marketplace insurance. This form can be 

obtained by calling the Marketplace at 1-800-318-2596. This is a common reject, so best practice is to 

see proof of insurance form (1095-A, 1095-B or 1095-C) to verify they did not have marketplace 

insurance. The information below is meant to help resolve some of these issues BEFORE the return 

rejects. 

i)​ Reasons people do not include marketplace insurance: 

(1)​ Taxpayer had Marketplace coverage in a prior year and was auto-renrolled. 
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(2)​ The taxpayer had short-term coverage but forgot or assumed it didn’t count. 

(3)​ Taxpayer didn’t realize the coverage was from the Marketplace: 

(4)​ They know the insurance company name but think it's employer or private coverage. 

(5)​ Fraudulent enrollment in coverage they didn’t apply for. 

ii)​ If the client cannot be sure but thinks they MAY have had Marketplace insurance (or you think it 
is reasonable to assume they did): Call the Marketplace with the client to clarify. Support the 
Client: 

(1)​ Prepare them for long hold times or complex calls. 

(2)​ Guide the conversation and help them explain the situation. 

(3)​ Emphasize that resolving the issue properly now prevents longer delays later. 

8)​ Additional Notes/Comments 

a)​ Use this section to document any additional information needed such as additional dependents that did 

not fit on page 1, any calculations done, or any other information the intake yielded that may be useful 

to the quality reviewer. 

9)​ CONSENT FORM: The Federal Intake Form contains Form 15080 to be signed by the client. Explain, “By signing 

this form, you are giving us permission to keep your basic information in our system for next year. When you 

return to any VITA site, your information will roll forward, making the process faster and easier. We ask for this 

consent every year, so you’ll always have the choice to agree or decline." 

MICHIGAN INTAKE SHEET 

1)​ Part I - SCHOOL DISTRICT: This should correspond to the client's address as of 12/31/2025. If unsure, see Tax 

Preparer Tools > State of Michigan > Michigan Tax Tools > School District Map 

2)​ Part II - EXEMPTIONS: In Michigan, receiving SSDI, SSI or VA disability benefits support the claiming of a special 

exemption for disabled Taxpayers 65 or younger. (refer to MI-1040 instructions, page 10 for details about Special 

Exemption eligibility) 

3)​ Part III - HOMESTEAD PROPERTY TAX CREDIT 

This credit is calculated by comparing the Taxpayer’s Total Household Resources with the amount of property 

taxes or rent paid throughout the year.  

Always check Taxpayer’s address on the Tax Exempt and Service Fee housing lists found at Tax Preparer’s Tools > 

State of Michigan > Homestead Property Tax Credit > Service Fee Housing List/Tax Exempt Housing Lists. Use 

Control F to search the address. Tax Exempt residences are not eligible for this credit. Residences with Service 

Fee status must be indicated as such on the return. 

a)​ Homeowners should present their summer and winter tax bills to be used in the calculation of this 

credit. An assessment showing the Taxable Value for their home in 2025 can also be used to calculate the 
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taxes levied. Find instructions at Tax Preparer’s Tools > State of Michigan > Homestead Property Tax 

Credit > Step-by_Step: MI Millage Rates. If the client has none of these, see your site coordinator 

i)​ See the Accounting Aid Compass for a step-by-step on calculating the property taxes based on 

millage rate. 

ii)​ If the millage rates are not on the website, the State of Michigan has not published them yet, 

clients must then provide property tax bills in order to calculate the credit. 

b)​ Renters are required to have a legal contract in order to claim this credit. If on a shared lease, the total 

monthly rent should be split evenly amongst listed tenants 

c)​ If the rental property is subsidized, the portion of rent paid by the Taxpayer is entered 

d)​ Service Fee Housing 

i)​ If the rental is categorized as Service Fee Housing, select only “Service Fee Housing” in TaxSlayer, 

do not also select “Subsidized.” 

e)​ Even if the housing is both subsidized and service fee, only choose “Service Fee Housing” and enter the 

taxpayer’s portion of the rent only (the non-subsidized portion). 

f)​ ⚠️ If both “Service Fee” and “Subsidized” are selected, TaxSlayer will treat the rental as fully subsidized 

and will not apply the 10% limitation required for service fee housing. 

4)​ Part IV - HOME HEATING CREDIT  

●​ This credit is based on a comparison between the taxpayer’s Total Household Resources (THR) and the amount 

they paid for heat in the previous year (or a standard allowance, if applicable). 

●​ Clients can usually find this amount on their December or January bill (DTE), any bill (Consumers Energy), or by 

calling their utility provider for the HHC amount. 

●​ For full eligibility details, see Tax Preparer’s Tools > State of Michigan > Home Heating Credit > MI CR-7 

Instructions (Page 11). 

5)​ Part V - NONTAXABLE INCOME (See Table 5) 

Ask clients ALL questions in this section. The income reported is used to calculate Total Household Resources. 

a)​ Child Support, Worker’s Comp, VA benefits, FIP: record amounts received 

b)​ SSI income for any household members should be entered here, as well as Social Security income 

received by dependents. (Only SSA-1099 income for the Taxpayer/Spouse is included in the Federal 

section) 

i)​ Received on the 1st of the month. Maximum monthly payments for 2025 are $967. There is no 

tax form for these payments, but some clients will have a benefits letter stating their payments. 

It is fine for clients to tell us what they received. SSI income is only included on the Michigan 

return. 

c)​ Gifts or Assistance from family/friends/agencies: any amount over $300 should be recorded. If your 

answer to #1 of the Due Diligence section is NO, revisit this question with your client. If they do not have 

enough income to substantiate their living expenses, it is likely that Michigan will refuse to issue their 

credits. If clients say they paid their bills using savings, they will need to paper file and include a letter 

explaining that they covered their expenses for the year by using their savings as well as bank account 

statements. 
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d)​ State SSI - The state of Michigan provides almost all SSI recipients state SSI. If the client or anyone 

claimed has SSI, ask if they also receive $42 every three months. 

6)​ Part VI -  HEALTH INSURANCE  

●​ Marketplace Insurance Premiums will not be known until a 1095-A has been entered into TaxSlayer. Once 

the Federal section is completed, reference Form 8962 to find the amounts for Marketplace Insurance 

Premiums and Premium Tax Credit. 

●​ Include any amounts paid for private health insurance premiums 

●​ Include any amounts in box 5 of the 1099-R that are used for health insurance premiums 

●​ Ask the client if they had car insurance for the year, if they did, find out if they paid or waived the PIP 

portion (they MUST provide proof of health insurance to their car insurance in order to do so). The state 

standard for PIP is $130 per vehicle. If the client can show a breakdown of what portion of the PIP was 

used towards medical insurance, that amount may be used, otherwise - use the standard $130 

7)​ Part VII - DUE DILIGENCE 
●​ Question 1 - if NO - client will be audited if they file - ask additional questions to find out how they can 

substantiate their expenses. Must be at least $1,000 more than their rent + utilities. See site coordinator 

for support. 

8)​ Part VIII CLIENT REVIEW AND AUTHORIZATION 

This is where the client will place their initials once they have looked over the QR sheet once the return has been 

entered into TaxSlayer - they should check each item and initial, acknowledging that they reviewed the 

information and it was correct. 

 

TAXPAYER QUESTIONS  

While you complete the return in TaxSlayer, ask the client to fill out this survey. Let them know that this 

information is for organizational purposes only and used when soliciting funds for the VITA program. If they are 

uncomfortable answering any of the questions, they can select “Prefer not to answer.”  

These questions should be answered by our clients and assumptions should not be made.  

 

 

 

 

PREPARING THE TAX RETURN IN TAXSLAYER 

IMPORTANT: DO NOT start a return in TaxSlayer if information is missing. Give your client the Missing Info Form detailing 
what they need to bring back to a rescheduled appointment. 
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Use ALL CAPS when inputting information. If prompted, always choose “ENTER MYSELF”. 
 
TAXSLAYER TASK ONE: ENTERING BASIC INFORMATION 

1)​ Enter Social Security number.  

2)​ If “Pulling Prior Year Data” appears 

a)​ Review items that will be pulled forward and uncheck any items that are not current. At this point, it is 
sometimes discovered that a tax document is missing (ex: W-2 or 1099-R). If that happens, the client 
must reschedule and return with the missing document(s). 

b)​ ALWAYS select “Yes, Import My Data” 
3)​ Filing Status: Determined from the Federal Intake Sheet (see above). DO NOT use Filing Status Wizard. 
4)​ Personal Information: Fill in completely 

a)​ Occupation field is optional  
b)​ Whether or not a checkbox needs to be selected is determined on the Federal Intake Sheet 
c)​ Spouse Information 

i)​ If MFJ, spouse must be present with ID 
ii)​ If MFS, client must have Spouse’s SSN in order to e-file. Otherwise, a dummy SSN can be used 

and the client must file a paper return (see site coordinator) 
5)​ Michigan Return 

a)​ School District (select according to where Taxpayer lived as of 12/31/2025)  
b)​ State Campaign Fund: see Michigan Intake Sheet 

6)​ Dependents or Qualifying Person(s): Enter information and check applicable boxes according to the Federal 
Intake Sheet. Social Security cards for dependents must be present. 

7)​ IP PIN: Found on notice CP01A from the IRS for tax year 2026. See note above if the IP PIN is missing.  
 

TAXSLAYER TASK TWO: COMPLETE FEDERAL SECTION 

1) FEDERAL INCOME  

Follow Page 2 of the Federal Intake/Interview Sheet to ensure that all income is reported on the tax return. See Table 1 

for instructions. The Form Finder in the upper left corner of TaxSlayer can be useful. 

*** WHEN A CLIENT HAS NO FEDERAL INCOME (ex: receives only SSI): Tax returns cannot be e-filed if the AGI is $0. To 

file this type of return and access Michigan credits: Go to Income > Other Income > Income Not Reported Elsewhere > 

enter $1 with the description “IN ORDER TO E-FILE.”*** 
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2026 TABLE 1 – INCOME 

INCOME TYPE 
(INTAKE SHEET, PAGE 2) 

 

BASIC OR 
ADVANCED 

SOURCE  
DOCUMENT 

FIND IN  
TAXSLAYER 

 
PUB 4012 

WAGES B W-2 Income > W-2 D-8 – D-11 

TIPS A W-2/CLIENT RECORDS Income > W-2 see site coordinator 

RETIREMENT,  
PENSION, ANNUITY 
 
 
 
 
 
 
RAILROAD RETIREMENT 
(TIER 2, GREEN FORM) 

 
B 
 
 
 

A 
 

 
A 

1099-R 
Box 7 codes 1 & 7 only 

 
 

1099-R 
All other Box 7 codes 

 
 

RRB-1099-R 

Income  > 1099-R > Add 
or Edit a 1099-R 
 
 
Income > 1099-R > Add or 
Edit a 1099-R 
 
 
Income > 1099-R, RRB > 
RRB-1099-R 

D-50 – D-54 
 
 
 

D-50 – D-54 
 
 
 

D-56 

DISABILITY BENEFITS B 1099-R 
 
 

W-2 

Income > 1099-R > Add or 
Edit a 1099-R 
 
Income > W-2 

 

SOCIAL SECURITY 
 
 
 
 
RAILROAD RETIREMENT 

B 
 
 
 
 

A 

SSA-1099 
 
 
 
 

RRB-1099 

Income > 1099-R, RRB, 
SSA > Social Security 
Benefits 
 
Income > 1099-R, RRB, 
Social Security > Social 
Security 
Benefits/RRB-1099 

D-57 – D-58 
 
 
 
 

D-57 
 

 

UNEMPLOYMENT B 1099-G Income > 1099-G Box 1 > 
Add or Edit a 1099-G 

D-6 

REFUND OF STATE/LOCAL 
TAXES 
(must have itemized 
deductions in 2025) 

 
B 

 
1099-G 

 
Income > 1099-G Box 2  

 
D-20 

INTEREST 
 
 
DIVIDENDS 

B 
 
 

B 

1099-INT 
 
 

1099-DIV 

Income > Schedule B > 
Interest or Dividend 
Income > Select matching 
form 

D-14 – D-16, 
D-18 – D-19 

SALE OF STOCKS, BONDS,  
 

 
 

1099-B 
 

Income > Schedule D > 
Stocks, Mutual Funds, 

 
D-32 – D-43 
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2026 TABLE 1 – INCOME 

 
REAL ESTATE 

A  
 

1099-S 

etc. 
 
Income > Schedule D > 
Sale of Main Home 

ALIMONY B Client Records Income > Alimony 
Received 

D-3, E-9 

INCOME FROM RENTALS A 1099-MISC, Box 1 In scope only for active 
duty military (see Site 
Coordinator) 

D-63 

GAMBLING WINNINGS B W-2G Income > Other Income > 
W2-G 

D-65 

SELF-EMPLOYMENT***  
 

A 

1099-NEC, Box 1 
 
 

1099-K 
 
 

Client Records 

Income > 1099-NEC 
 
 
Income > 1099-K > 
Continue to Schedule C 
 
Income > Schedule C 

 
 
 

D-21 – D-30 

OTHER INCOME 
JURY DUTY 
 
SCHEDULE K-1 
 
 
ROYALTIES 

 
B 
 

B 
 
 

B 

 
Client Records 

 
K-1 

 
 

1099-MISC 

Income > Other Income > 
Other Income 
 
Income > Other Income > 
K-1 Earnings 
 
Income > 1099-Misc Box 
2 

D-65, E-4 
 
 
 

D-59 – D-62 
 
 
 

 

***SELF-EMPLOYMENT requires a Schedule C that includes income, related expenses and a description of the work 

performed. Entering a 1099-NEC or 1099-K in TaxSlayer will initiate the Schedule C. If there is no 1099, access the 

Schedule C directly from the Federal Income page. Use the Schedule C worksheet available at your tax site to establish 

income and expenses. Remember that AAS cannot use gas expenses for drivers, only mileage 
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2) Expenses:  Follow the first two sections of Page 3 on the Federal Intake/Interview Sheet. 

2026 TABLE 2 – EXPENSES 

TYPE OF EXPENSE 
(INTAKE SHEET, PAGE 3) 

BASIC OR 
ADVANCED 

SOURCE 
DOCUMENT 

FIND IN 
TAXSLAYER 

 
PUB 4012 

DEDUCTIONS 
    *Make entries  
      ONLY if taxpayer will be  
      itemizing deductions 
 

MORTGAGE INTEREST 
 
 
 
TAXES (State, Local, Real 
Estate, Sales, Etc.) 

 
 
MEDICAL/DENTAL/ 
PRESCRIPTIONS 
CHARITABLE 
CONTRIBUTIONS 

 
 
 
 
 

A 
 
 
 

A 
 

 
 

A 
 
 

A 
 
 
 

 
 
 
 

 
1098 

 
 
 

Tax bill/auto 
registration 

 
 

Client records 
 
 

Client records 
 

 

 
 
 
 
 
Deductions > Itemized > 
Mortgage Interest/Exp 
 
 
Deductions > Itemized > 
Taxes You Paid 
 
 
Deductions > Itemized > 
Medical, Dental and Vision 
 
 
Deductions > Itemized > Gifts 
to Charity 
 
 

 
 
 
 
 

F-14 
 

 
 

F-10 
 

 
 

F-8 
 
 

F-16 
 
 

STUDENT LOAN 
INTEREST 

B 1098-E Deductions > Adjustments > 
Student Loan Interest 

E-17 

CHILD AND DEPENDENT 
CARE 

B Statement from 
daycare provider 

Deductions > Credits > Child 
and Dependent Care  

G-12 – G-14 

CONTRIBUTIONS TO 
RETIREMENT ACCOUNT 

B 
 
 
 

A 
 

5498 - ROTH IRA 
 
 
 
 

5498 - IRA 

Deductions > Credits > Credit 
for Qualified Retirement 
Savings Contributions 
 
Deductions > Adjustments > 
Traditional IRA Contributions 

 
G-17 – G-20 

SCHOOL SUPPLIES 
BOUGHT BY EDUCATOR 

B Client records 
(limit $300) 

Deductions > Adjustments > 
Educator Expenses 

E-8 

ALIMONY PAYMENTS B Client records Deductions > Adjustments > 
Alimony Paid 

E-14 
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3) Life Events 

Follow the third section of Page 3 on the Federal Intake/Interview Sheet. 

2026 TABLE 3 – LIFE EVENTS 

TYPE OF EVENT 
(INTAKE SHEET, PAGE 3) 

BASIC OR  
ADVANCED 

SOURCE  
DOCUMENT 

FIND IN 
TAXSLAYER 

 
PUB 4012 

EDUCATIONAL CLASSES B 1098-T Deductions > Credits > 
Education Credits 

 

SELL A HOME  1099-S 
Closing papers 

Income > Schedule D > 
Sale of Main Home 

D-40 – D-43 

HEALTH SAVINGS 
ACCOUNT 

A W-2 > Box 12 > Code 
W 
5498-SA & 1099-SA 

 E-10 

MARKETPLACE 
INSURANCE *** 

A 1095-A Health Insurance  

PURCHASE OF ENERGY 
EFFICIENT HOME ITEMS 

A Client records Deductions > Credits > 
Residential Energy Credits 
> Qualified Energy 
Efficiency Improvements 

 

CANCELLATION OF DEBT 
(Credit Card, Mortgage) 

A 1099-C 
1099-A 

Income > Other Income > 
1099-C 

 

FEDERAL DISASTER AREA 
LOSS 

    

TAX CREDIT DISALLOWED 
IN PRIOR YEAR (Earned 
Income, Child Tax Credit, 
Amer. Opportunity Credit) 

B Client records, 
Letter from IRS 
Form 8862 

 I-8 

ESTIMATED TAX 
PAYMENTS OR APPLY 
PREVIOUS YEAR’S REFUND 

A Client records 
Prior tax return 

  

 

*** MARKETPLACE INSURANCE: For every tax return, the Tax Preparer must go to the Health Insurance Tab and 

report if the client had coverage through the Affordable Care Act, a question from the Life Events section of the intake 

interview. If the client had Marketplace Insurance, they should have received Form 1095-A, which will be entered here. 
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IMPORTANT: After entries were made from Tables 1 - 3 (or if no entries were made), additional entries may be needed! 

 

TAXSLAYER TASK THREE: COMPLETE STATE SECTION   

Navigate to State Section Tab > click on Edit (Blue Pencil Icon) 

1)​ School District – If not auto-filled, select the Taxpayer’s school district, as of 12/31/2025. Be aware that the 

school district may be different than the city the client lives in 

2)​ Basic Information – Special Exemptions:  

a)​ Taxpayer/Spouse 

b)​ Dependents 

c)​ Qualified Disabled Veterans (can be used in combination with other special exemption) 

d)​ Stillbirth 

3)​ Subtractions from Income – Not all income that is taxable at the federal level is taxed in Michigan. Most 

subtractions are calculated automatically, but some must be entered manually. ( See site Coordinator) 

a)​ Deduction Based on Year of Birth for pensions 

b)​ Phase In Subtraction  

Find guidelines at Tax Preparer Tools > State of Michigan > NEW Michigan Pension Chart 

c)​ U.S. Military/Michigan National Guard/Railroad Retirement Benefits 

d)​ State and Local Income Tax Refund (only if client itemized deductions in 2024) 

4)​ Credits 

a)​ Homestead Property Tax Credit 

i)​ Homeowner 

(1)​ Select that the Taxpayer is eligible for the credit and a Homeowner 

(2)​ Begin Part 1 

(3)​ Enter the Taxable Value and Taxes Levied according to the Michigan Intake Form 

(4)​ If client bought or sold their home in 2025, see your Site Coordinator 

ii)​ Renter (unsubsidized) 

(1)​ Select that the Taxpayer is eligible for the credit and a Renter 

(2)​ Begin Part 2 

(3)​ Enter all rental information according to the Michigan Intake Form, including any 

changes to monthly rent or address 

iii)​ Occupant of Housing Facility (Subsidized, Service Fee, Co-op, Nursing Home, Assisted Living, etc.) 

(1)​ Select that the Taxpayer is eligible for the credit and a Renter 

(2)​ Begin Part 3 

(3)​ Enter the appropriate type of housing 

(4)​ If subsidized or service fee, enter the total rent paid BY THE TAXPAYER for the year. If 

housing was both subsidized and service fee, always select Service Fee Housing 

(5)​ If residence is one of the other options, enter prorated share of taxes provided by the 

client from the housing facility 

b)​ Home Heating Credit – See MI-1040CR-7 Instructions Book  

i)​ Always answer YES for eligibility 
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ii)​ Select the client's County, Heat Type (natural gas), and Heat Provider. 

iii)​ U.S. Citizen or Qualified Alien Status. This will almost always be yes. See Page 6 of MI-1040 CR-7 
Instruction Book 

iv)​ Indicate if the client’s heat is included in their rent 
v)​ Indicate if client or spouse receives SSI 

vi)​ The total amount charged for heat in 2025 can be found on the Taxpayer’s Dec/Jan gas bill and 
entered as an exact amount. This space can also be left blank and a standard formula will be 
used in the calculation 

vii)​ Select a CARE facility if applicable. If they were a part-year resident, see Site Coordinator 
viii)​ Always answer YES for refund eligibility 

ix)​ For shared credit or part-year residents, see your Site Coordinator 
c)​ Total Household Resources – This is where any nontaxable income is recorded. It is only needed when 

applying for the Michigan tax credits. 

i)​ Record all non-taxable income from the Michigan Intake sheet Part V. (See Table 5) 

ii)​ Medical insurance/HMO premiums 

 

2026 TABLE 4 – NONTAXABLE INCOME 

TYPE OF INCOME 
(MI. INTAKE, PART V.) 

 
SOURCE DOCUMENT 

 
FIND IN TAXSLAYER 

 

MI-1040 
 INSTRUCTIONS 

  Credits > Homestead 
Property Tax > Total 
Household Resources > 

 

1. CHILD SUPPORT Client records Enter amount of Child 
Support 

 

2. WORKERS 
    COMPENSATION 
 
    V.A. BENEFITS 

Letter/client records 
 
 
Letter from V.A./ 
Client records 

Enter any Workers Comp, 
Veterans Disability Comp 
and pension benefits 
received that are not 
included on Federal 1040 

 

3. FIP/MDHHS BENEFITS Annual statement 
from MDHHS 

Enter amount of FIP and 
other MDHHS benefits 
received. DO NOT 
INCLUDE Food Assistance 
benefits. 

 

4. SOCIAL SECURITY 
    RECEIVED BY 
    DEPENDENTS 

 
SSA-1099 
 

Enter any additional 
Social Security Benefits 
and Supplemental 
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2026 TABLE 4 – NONTAXABLE INCOME 

  
    SUPPLEMENTAL 
    SECURITY INCOME 
    (FOR TP, SPOUSE, OR 
    DEPENDENT) 

 
SSI Benefits Letter 
 

Security Income (SSI) that 
was NOT reported on 
your federal tax return 

5. GIFTS OR ASSISTANCE Client records Enter amount of gifts/ 
assistance paid on your 
behalf 

 

6. OTHER NONTAXABLE 
    STATE SSI 
 
    ANY OTHER  

Letter from MDHHS/ 
Client records 
 
Client records 

Enter any other 
nontaxable income 
 
Enter description 

 

 

5)​ City of Detroit Return: All Taxpayers who live or work in Detroit and have taxable income must complete a City of 

Detroit return. Michigan Return > City of Detroit Return 

NOTE: If the Taxpayer worked in a taxing city (Detroit, Hamtramck, Highland Park, etc.) and lived in a different 
taxing city, complete the non-resident city CF-1040 first and then the resident city return 

a)​ Resident of Detroit 

i)​ Additions – If a 1099-R has code 1 (early distribution) in Box 7, add the income back 

ii)​ Subtractions 

(1)​ Retirement/Pension and Social Security – only taxed if early distribution. If TaxSlayer 

does not automatically subtract retirement income, subtract it manually 

(2)​ Unemployment Compensation (same as retirement) 

iii)​ Payments and Credits: Income taxes paid to another city 

iv)​ Detroit Miscellaneous Forms (See Site Coordinator) 

b)​ Non-Resident (worked in Detroit, lived outside Detroit) 

i)​ Wages should be allocated if the Taxpayer had income that was not earned in Detroit.  

ii)​ Subtractions – see Resident return above 

iii)​ Payments and Credits – If filing resident return with another taxing city 

iv)​ Detroit Miscellaneous Forms – if TaxPayer has made estimated payments to Detroit, enter the 

amounts here 

c)​ Part-year Resident (see Site Coordinator) 

 

6)​ Localities (CF-1040 for Taxing Cities other than Detroit): All Taxpayers who live or work in a taxing city and have 

taxable income must complete a CF-1040. Other than for Detroit, city returns must be paper filed, with Federal 

1040 and any W-2/1099-R’s with city taxes withheld attached. 
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Access the MI City Form CF-1040 by exiting Michigan Return and clicking +Localities.  

There are 24 taxing cities in Michigan (Commonly seen: Highland Park, Hamtramck, Pontiac). A complete list can 

be found at Tax Preparer Tools > City > List of Taxing Cities. Each city has its own instructions. When entering city 

withholdings in Federal Income, city codes must be entered exactly as written on the list at the bottom of 

Taxslayer (MAY BE DIFFERENT THAN WHAT IS WRITTEN ON THE W-2). 

a)​ Wages and Excludable Wages 

b)​ Adjustments to Income 

c)​ Deductions 

d)​ Payments and Credits 

e)​ Non-Electronic Direct Debit/Deposit 

TAXSLAYER TASK 4: E-FILE PAGE 

1)​ Return Details 

a)​ Federal Return: select applicable option 

b)​ State Return: select applicable option 

c)​ Form 8879: enter client’s email, if provided 

2)​ Fee Summary: click continue 

3)​ Bank Account Info enter type of account, routing and account numbers. Pull refund 

4)​ State ID License: optional – can select Not Provided 

5)​ Taxpayer Consent: Present the consent form on the back of the Federal Intake Sheet and have the client (and 

spouse if MFJ) sign it.  

Select accept and enter the taxpayer’s zip code and the date. The client gives us permission to do so when they 

sign the 8879 BEFORE we can file the return. 

6)​ Custom Questions: Copy your client’s answers from the Tax Payer’s Questions 

7)​ Custom Credits:  

Navigate to State Section > click the Printer Icon > Record the Property Tax Credit, Home Heating Credit and City 

tax due/owed to DETROIT ONLY on Tax Preparer’s Questions. Tax owed to Detroit should be entered as a 

negative number. 

Return to E-File > Custom Credits and enter the amounts.  

8)​ Submission Page: > Print Tax Documents > select Quality Review from drop-down menu 

a)​ Custom print the QR sheet only 

b)​ Highlight the client’s name, address, SSN, DOB, phone number and, if applicable, their dependent(s) 

information and routing and account numbers.  

c)​ Have your client review the highlighted information and initial the corresponding lines on Michigan 

Intake Sheet Part VIII. 
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QUALITY REVIEW AND PRESENTING THE TAX RETURN 
 
At this point, ask your site coordinator or another designated available tax preparer to Quality Review the tax return. 
Once the QR is complete, the reviewer will print out the tax return. 
 

1)​ Assemble the Tax Return 
a)​ Complete and attach the Cover Sheet to tax return 
b)​ Payments: For any amount owed to IRS, Michigan or Detroit, a payment voucher and instructions will be 

included in the return. Extract these and find the matching payment envelopes to give to the client. 
c)​ Paper Returns: See Tax Preparer Tools > Federal > Tools > “Paper Filing Instructions”  

2)​ Present the return to the Tax Payer 
a)​ Go over the basics of the cover sheet 
b)​ Go through the tax return and explain in more detail. Invite questions 
c)​ Have the client sign the e-file consent. This should be the first page of the return and is required before 

submitting the return. Explain to the client before signing that by signing the return, they are confirming 
all information provided is correct and that they are responsible for the accuracy of the return.Their 
signature also authorizes us to e-file on their behalf and share their return with the IRS. 
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